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1.

System Overview

System Overview

The LORD MicroStrain® family of industrial and tactical grade inertial sensors provide a wide
range of triaxial orientation measurements and computed navigation solutions. In all models, the
Inertial Measurement Unit (IMU) includes direct measurement of acceleration and angular rate,
and some also offer atmospheric pressure readings. Sensor measurements are processed
through an Extended or Adaptive Kalman Filter (EKF/AKF) to produce highly accurate computed
outputs. The computed outputs vary between models and include: pitch and roll in the 3DM-GX415™ IMU/VRU model, the full attitude solution (pitch, roll, and yaw) in the 3DM-GX4-25™ AHRS
model, and the full PVA (position, velocity and attitude) solution in the 3DM-GX4-45™ and 3DMRQ1-45™ GPS/INS, and 3DM-GQ4-45™ GNSS/INS models. The Kalman filter provides EKF
technologies to compensate for magnetic and linear acceleration anomalies as applicable to the
model. It also provides sensor bias tracking, auto- zero update options (ZUPT), and user
adjustable sensor noise factors. All sensors are fully temperature compensated and calibrated
over the full operating temperature range.
The use of Micro-Electro-Mechanical System (MEMS) technology allows for small, lightweight
devices. Sensors are integrated into customer systems using serial communication protocols such
as RS422, RS232 and USB. The LORD MicroStrain® MIP™ Monitor software can be used for
device configuration, real time measurement monitoring, and data recording. The LORD
MicroStrain® MIP ™ Data Communications Protocol that is used to communicate with LORD
MicroStrain® inertial sensors is also available for users who want to develop customized software
solutions. Because of the unified set of commands across the sensor family, it is easy to migrate
code from one inertial sensor to another.
Common applications of LORD MicroStrain ® inertial sensor products include vehicle health
monitoring, platform stabilization, down- hole and drilling operations, and inertial navigation
systems such as unmanned air and ground vehicles and personal navigation systems.
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2.

Sensor Overview

Sensor Overview

The 3DM-GQ4-45™ is a high-performance, GNSS-Aided Inertial Navigation System (GNSS/INS)
that combines micro inertial sensors and a high-sensitivity embedded Global Navigation Satellite
System (GNSS) receiver for use in a wide range of tactical grade applications, such as unmanned
vehicle navigation, robotic control, platform stabilization, motion tracking and analysis, vehicle
health monitoring, and device aiming.
The 3DM-GQ4-45™ utilizes the strengths of integrated multi-axis gyroscopes, accelerometers,
and magnetometers in combination with GNSS, temperature, and pressure readings to provide
highly accurate position, velocity, attitude (including heading), and inertial measurements. Each of
the integrated sensors is especially good at certain tasks, and it is the weighted combination of
their outputs that provides the best estimations for position, velocity, and attitude. All sensor
measurements are temperature compensated and are mathematically aligned to an orthogonal
coordinate system. The combination of sensors, environmental compensation, and dual on-board
processing with an Extended Kalman Filter (EKF) allows the 3DM-GQ4-45™ to perform well in a
wide variety of applications that require low noise, drift, gain, and offset errors. Uncertainty
monitoring, scale factor estimation, and bias estimation outputs are available, and settings for
sensor filtering, sensor noise, sensor bias, and more offer many adjustments for specific
application needs.
The 3DM -GQ4 - 45 ™ communicates through a serial connection and is monitored by a host
computer. A detachable GNSS antenna is plugged into the sensor and positioned with
unobstructed line of sight to the sky to obtain satellite links. Sensor measurements and computed
outputs can be viewed and recorded with the LORD MicroStrain® MIP™ Monitor software that is
provided with system starter kits and also available as a free download from the LORD
MicroStrain® website. Alternatively, users can write custom software with the LORD MicroStrain®
open source data communication protocol. The data is time-aligned and available by either polling
or continuous stream.

Figure 1 - 3DM-GQ4-45™ Sensor
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2.1

Sensor Overview

Components

The 3DM -GQ4- 45™ can be purchased by itself or in a starter kit that includes everything
needed to begin using it. The starter kits include the 3DM-GQ4-45™ inertial sensor, a serial
communication cable (either RS232 or USB), a power supply with international plug adapters
(RS232 kits only), an external GNSS antenna with a three-meter cable, a non-magnetic GNSS
antenna adapter cable, and all software, drivers, and documentation. This manual covers all
items included in the starter kits. For a complete list of available configurations, accessories,
additional system products, and ordering information see Parts and Configurations on page
66see Parts and Configurations on page 66.

Item
A
B
C
D
E
---

Description

1

Communications cable (USB or RS232)

1

Power supply and plug adapters (for RS232 only)

1

GNSS antenna with attached cable (3m SMA)

1

GNSS antenna cable adapter (non-magnetic MMCX-to-SMA)

1

MIP™ Monitor Software Suite

1

User Documentation and Calibration Certificate

1

Table 1 - Starter Kit Components List
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2.2

Sensor Overview

Interface and Indicators

The 3DM-GQ4-45™ sensor interfaces include a communications and power input connector
and a GNSS antenna port. The sensor is mounted using the mounting and alignment holes as
needed (see Sensor Mounting on page 48).
The indicators on the 3DM - GQ4 - 45 ™ include a device status indicator and the device
information label. Table 2 - Indicator Behaviors describes the basic status indicator behavior.
The device information label includes the sensor frame diagram (axis orientation), which will be
critical during device installation (see Sensor Frame on page 33).

Figure 2 - Interface and Indicators

Indicator

Behavior

Device Status

device status
indicator

OFF
rapid flash
steady blink
slow pulse

no power applied
streaming data with no GNSS lock
streaming data with GNSS lock
idle mode, awaiting commands

Table 2 - Indicator Behaviors
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3.

Basic Setup and Operations

Basic Setup and Operations
Do not put the 3DM-GQ4™ in contact with or in close proximity
to magnets. Magnets may disrupt operation and cause
magnetization of internal components, which can affect
magnetometer performance. If magnetization is suspected,
use a degaussing tool to demagnetize.

To acquire sensor measurements and computed outputs, the 3DM - GQ4 - 45 ™ uses a host
computer, a serial communications port, and applicable software. The LORD MicroStrain ®
MIP™ Monitor software is provided with the system and includes all functions needed for sensor
configuration and data acquisition. Users may also utilize the LORD MicroStrain® MIP™ Data
Communications Protocol to write custom software applications with expanded or specific feature
sets needed for the application. MIP™ Monitor includes a message building tool that can be used
to streamline this process. For more information see OEM System Integration on page 50.
In this section hardware and software setup is described, including an overview of the
MIP™ Monitor software menus required to configure a sensor and begin data acquisition. This is
intended as a quick start guide and is not a complete demonstration of all system or software
features and capabilities.

Figure 3 - Acquiring Sensor Data with MIP™ Monitor
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3.1

Basic Setup and Operations

Software Installation
NOTE

The MIP™ Monitor Software Suite includes hardware drivers required for 3DMGQ4™ sensor operation. Sensors will not be recognized without these drivers
installed.

To install the MIP™ Monitor Software Suite on the host computer, complete the following
steps:
1. Launch the software installation menu by inserting the software CD or thumb drive
into the host computer or, by running the Autorun.exe file from the software
directory in Windows® Explorer.
2. In the software installation (Figure 4 - Software Installation Menu) menu select
"Install MIP Monitor Software" and follow the on-screen prompts to completion.
3. If the sensor has internal magnetometers, select "Install MIP Hard and Soft Iron
Calibration Software" and follow the on- screen prompts to completion. This is
used for magnetometer field calibration.
4. Select "Install Inertial Drivers" to install the hardware drivers required for operating
the sensors, and follow the on-screen prompts to completion.
5. Select "Install Inertial Manuals", if desired, and reboot the host computer.
6. Plug the communications adapter into the host computer, and the drivers will
install automatically. Reboot the computer when complete.

Figure 4 - Software Installation Menu
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3.2

Basic Setup and Operations

System Connections
Power is applied to the sensor either through a host computer
USB port or an external power supply, such as the one
provided in the RS232 starter kit. Use only power supplies
within the operating range of the sensor, or damage or injury
could result. Once power is applied the sensor is on and active
(see Specifications on page 70).

To acquire sensor data the following components are needed: 3DM - GQ4 - 45 ™ sensor,
communication cable, power cable (as applicable for RS232 communications) , GNSS
antenna, GNSS antenna adapter cable, and a host computer with LORD MicroStrain ®
MIP™ Monitor installed.

Figure 5 - System Connections

13

3DM-GQ4-45™ Inertial Navigation System User Manual

3.3

Basic Setup and Operations

Software Interface

The MIP™ Monitor software includes a main window with system information and menus, a
device settings window ( see Sensor Settings on page 17 ), and several data monitoring
windows (see Data Monitoring and Recording on page 19).
The main window provides an overview of connected devices. Devices are selected by clicking
on them. A device menu is available by right-clicking on the device name and includes the most
used items from the header row menus (Figure 6 - Main Window ). The header row menu
includes selections for data sampling, recording, device settings, opening windows, selecting
which open window to view, and advanced features such as selecting the communications
mode. The icon toolbar includes buttons for Help Menu access, device refresh, and data
sampling and recording (see Data Monitoring and Recording on page 19).

Figure 6 - Main Window

3.3.1

Interactive Help Menu

MIP ™ Monitor also includes a mouse- over feature that provides explanations of the
information and settings. This feature is enabled by selecting the question mark icon or Help
button in any window.

Figure 7 - Context Sensitive Help Menu
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3.4

Basic Setup and Operations

Sensor Communication

Once power has been applied to the sensor, it is on. The sensor selects the appropriate serial
communication (USB or RS232) on power- up based on which cable is connected. If the
hardware drivers have been installed, communication can be established using the
MIP ™ Monitor software interface. GNSS lock is not required to establish sensor
communication.
1. Verify the sensor device status indicator is on.
2. Open the MIP™ Monitor software.

3. The sensor should appear in the device list automatically when the software is
running. The list includes the device information and communication port assignment
(Figure 8 - Sensor Communication). If the sensor is not automatically discovered, use
the refresh button.

Figure 8 - Sensor Communication
NOTE
If data is not actively being exchanged between the sensor and host computer, the
status message may display Not Connected. This indicates the port status, not the
sensor availability. When commands are sent to the sensor, the software will
automatically connect to it before sending the message.
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3.5

Basic Setup and Operations

GNSS Satellite Link
NOTE

The GNSS antenna requires unobstructed line of sight with the sky in order to achieve
communication with the GNSS satellites.

Communication between the GNSS receiver and GNSS satellites is initiated when the 3DMGQ4-45™ is first powered on. The status indicator on the device will blink differently to show if a
satellite link has been established (see Interface and Indicators on page 10). The receiver will
continuously search for satellites until a link is established. When the link is established the
GNSS Monitor window in the MIP™ Monitor software will display the satellite and link statistics
(see Global Navigation Satellite System (GNSS) Outputs on page 26).
Communication with the satellites is required for proper sensor operation, although some
measurement outputs will be available without it.
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3.6

Basic Setup and Operations

Sensor Settings

Device settings are stored in the sensor memory. Only the configuration options that are
available for the type of sensor being used will be available in the configuration menus.
1. To enter the settings menu, right-click on the sensor name, and select Device Settings:
a. Main menu tabs: The main tabs break up the setting into broad functional groups for the
types of measurement available. For the 3DM-GQ4-45™ these include calculated measurements (Estimation Filter), GNSS metrics (GNSS), and direct inertial sensor measurements (IMU/AHRS).
b. Message Format (first sub-menu tab): Under each main menu tab there are additional
sub-menu tabs, including the Message Format tab. The Message Format tab allows the
user to select the measurement type to be displayed and recorded (b1) and the data rate
(rate at which data is sent to the host computer) in samples/second (b2).
c. Measurement parameters (other sub-menu tabs): Available sub-menu tabs besides
the Message Format tab depend on the selected main menu tab. These tabs include the
configurable settings for each measurement. GNSS
d. Scrolling: used to navigate to additional sub-menus
e. Help menu: Enable the context-sensitive help menu for explanations of specific settings
(see Interactive Help Menu on page 14).

Figure 9 - Device Settings Menu
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Basic Setup and Operations

NOTE
When selecting sensor and estimation outputs to be recorded, communications
bandwidth considerations should be taken into account, especially when using RS232
communications. Lower baud rates equate to lower communications bandwidth,
which can be consumed quickly by selecting a large number of measurements at high
sample rates. Overrunning the communications bandwidth will result in dropped
communications packets and lost data.

3.6.1

Saving Configurations

Sensor settings are saved temporarily by selecting the OK button in the Device Setup
window after configuration, but they are lost when the device is powered off. To save
current settings in the device memory for the future, use the Save Current Settings feature.
First adjust the sensor settings to the desired values. Next select Settings > Save Current
Settings from the main window (Figure 10 - Save Sensor Settings). The setting will now
remain intact when the sensor is powered off and then on again.
To recall the last saved settings select Settings > Load Startup Settings. To revert the
settings back to the factory defaults, select Settings > Load Default Settings.

Figure 10 - Save Sensor Settings
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3.7

Basic Setup and Operations

Data Monitoring and Recording
NOTE

During viewing and recording, only the outputs that are selected in the Message
Format tabs in the Device Setup menu are displayed and recorded ( see Sensor
Settings on page 17).

Throughout the MIP ™ Monitor menus the same icons are used to control data streaming
(sampling) and recording ( Table 3 - Sampling and Recording Controls). These icons can be
found in the MIP™ Monitor main window icon toolbar and in each data monitoring window. The
same commands are also found in the main window Control menu.

Figure 11 - Main Window Controls

Icon

Command
Run: start data streaming
Stop: end data streaming
Step: sample single set of data
Record: start and stop data recording

Table 3 - Sampling and Recording Controls
There are several data monitoring views available depending on what measurements are
desired for monitoring and recording. Each view corresponds to one of the main categories in
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Basic Setup and Operations

the Device Settings window. For example, the 3DM - GQ4 - 45 ™ includes Sensor Data
Monitoring for the IMU/AHRS measurements, GNSS Monitoring for the GNSS metrics, and
EF Monitoring for the Estimation Filter outputs (Figure 12 - Data Streaming). During viewing
and recording only the outputs that are selected in the Message Format tab of the Device
Settings menu are displayed and recorded (see Sensor Settings on page 17).
Data streaming must be started before data can be recorded, however it is not necessary to
view it in a data monitoring window. Data monitoring is used primarily to confirm the system is
operating correctly or to view the outputs in near real time. If sensor setup has already been
confirmed, streaming and recording can be initiated from the main window.
Figure 12 - Data Streaming is an example of Sensor Data Monitoring, which displays the
selected IMU/AHRS measurements. In data monitoring windows, no data will be displayed
until data streaming is started, and no data will be recorded (even if it is being viewed) until data
recording is initiated (armed). In the example below, the y- axis of the graph indicates data
points, the x-axis is the measurement units, and there is a tab for each measurement.
1. Right-click on the device in the main window and select Sensor Data Monitoring.
2. Press the Start Streaming icon to start sampling.

Figure 12 - Data Streaming
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Basic Setup and Operations

3. To record data, select the Arm Recording icon at any time.
4. Select the type of data file to generate: Binary or CSV. The CSV file is the most
common and can be viewed and processed by data editors such as Microsoft Excel ®.

NOTE
If the data is recorded in Binary format it will require a translation program that
utilizes the LORD MicroStrain® MIP™ Data Communications Protocol to make
it user-readable.

Figure 13 - Data Recording
5. To end recording press the Arm Recording button again, and select OK in the
confirmation prompt window.
6. Select the Stop Streaming icon to end sampling.
7. Use the red "X" in the upper right of the sensor monitoring window to exit monitoring
mode.
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3.8

Basic Setup and Operations

Viewing Data

Acquired data is stored in either Binary (.bin) or Comma Separated Values (.CSV) format,
depending on what was selected at the initiation of data recording. The files can be found in the
directory specified at that time or in the default directory on the host computer desktop.
CSV files can be viewed with Microsoft Excel, Quattro Pro, Open Office, or other CSV editors
and spreadsheet programs.
Data recorded in Binary format requires a translation program utilizing the LORD MicroStrain®
MIP™ Data Communications Protocol to make it user-readable.

Figure 14 - Exploring Data

NOTE
Data in the data files is displayed in time sequence. If measurements are set to
different data rates, not all time intervals will include a reading from each output that is
being recorded.
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4.

Sensor Measurements

Sensor Measurements

The 3DM-GQ4-45™ block diagram (Figure 15 - 3DM-GQ4-45™ Block Diagram ) describes its
primary hardware components and internal configuration. Integrated Micro-Electro-Mechanical
System (MEMS) sensors within the 3DM - GQ4 - 45 ™ are collectively known as the Inertial
Measurement Unit (IMU) and include tri-axial gyroscopes (gyros), tri-axial accelerometers, tri-axial
magnetometers, and a pressure altimeter. This technology provides direct measurements of
acceleration, angular rate, magnetic field, pressure, delta-Theta (change in acceleration), and
delta- v (change in velocity). Temperature and pressure sensors provide environmental
information for measurement compensation and altitude estimations. GNSS information can be
read directly and is also used in the computed navigation estimations.
Computed estimations for position, velocity, and attitude (PVA) are available outputs on the 3DMGQ4-45™. To achieve these estimations, the MEMS sensors and GNSS solution are blended
together in a loosely-coupled Extended Kalman Filter on a dedicated filter processor. Additional
user settings such as measurement filtering, biasing, and tolerance values offer adjustments for
specific applications.

Figure 15 - 3DM-GQ4-45™ Block Diagram

23

3DM-GQ4-45™ Inertial Navigation System User Manual

4.1

Sensor Measurements

Direct Sensor Measurements (IMU Outputs)

The sensors in an Inertial Navigation System (INS), from which measurements for navigation
and orientation are obtained, are collectively known as the Inertial Measurement Unit (IMU).
These sensors are arranged on the three primary axes (x, y, and z) to sense angular rate,
acceleration, and the local magnetic field . The gyroscopes are used to adjust the current
attitude estimate when an angular rate is sensed. The accelerometers sense gravity as well as
linear acceleration. The magnetometers sense the Earth’s magnetic field along with local
magnetic anomalies. All measurements are temperature-compensated and are mathematically
aligned to an orthogonal coordinate system.
The IMU sensors can be read directly to report stand alone inertial measurements or computed
measurements. Because the sensor system is digital, the analog voltage readings from the
sensors are converted into a digital equivalent value based on the volt-to-bit scale of the internal
analog-to-digital voltage converter. In the MIP™ Monitor software the conversion values are not
configurable, but there are user- settable options for how the measurement is made. These
settings are available at: Settings > Device > IMU (tab). With the Help window open (accessed
with the Help button), mousing over context-sensitive settings provides a detailed explanation
of the setting (Figure 16 - IMU Settings).

Figure 16 - IMU Settings

24

3DM-GQ4-45™ Inertial Navigation System User Manual

Sensor Measurements

Table 4 - IMU Measurements lists the IMU measurements available for the 3DM-GQ4-45™.
Additional measurement units may be available in MIP™ Monitor for some outputs, however
they are converted values and do not represent the actual sensor outputs. Only actual output
units are listed.
The Complementary Filter (CF) attitude, and up and north vector outputs are computed
estimations from the LORD MicroStrain® 3DM-GX3® inertial sensor family and are available to
maintain backwards compatibility. For new applications it is recommended that these
estimations be computed with the 3DM-GQ4™ EF Outputs algorithms (see Computed Outputs
(Estimation Filter) on page 28).
To view and record IMU outputs, see Basic Setup and Operations on page 11.

Measurement

Units

Acceleration

gravitational force (g)

Magnetic Field

Gauss (G)

Angular Rate

radian/second

Delta Angle (Theta)

radians

Delta Velocity

g*seconds

GPS Correlation
Timestamp

weeks, seconds, and
status indicators

Ambient Pressure

millibars

CF Attitude
(Euler RPY)
CF Attitude
(Matrix)
CF Attitude
(Quaternion)
CF North Vector
CF Up Vector

radians
-----

Description
three axis acceleration readings in
engineering units
three axis magnetic field readings in
engineering units
three axis rotational velocity reading from
gyroscope in engineering units
time integral of angular rate with
configurable time period
time integral of acceleration with
configurable time period
time metrics from the GNSS receiver for
tracking IMU sensor data
air pressure reading from
pressure sensor
Complementary Filter (CF) Euler angles
representation of orientation
Complementary Filter (CF)
matrix representation of orientation
Complementary Filter (CF)
quaternions representation of orientation
Complementary Filter (CF) north vector
Complementary Filter (CF) up vector

Table 4 - IMU Measurements

25

3DM-GQ4-45™ Inertial Navigation System User Manual

4.2

Sensor Measurements

Global Navigation Satellite System (GNSS) Outputs

The Global Navigation Satellite System (GNSS) receiver in the 3DM-GQ4-45™ uses its own
GNSS positioning engine to calculate a position, velocity, and time solution, and it requires a
minimum of four satellites. Accuracy and reliability of the GNSS readings are highly dependent
on the quality of the satellite fix, and information is provided to determine an appropriate
confidence level. External aiding systems, such as Wide Area Augmentation System (WAAS)
in the US, help compensate for certain error sources that can affect GNSS accuracy. Position
of the antenna is also an important consideration (see GNSS Antenna Installation on page 49).
Readings and information are available directly from the GNSS receiver. Table 5 - GNSS
Outputs describes the available outputs. GNSS reporting and recording can be enabled in the
MIP™ Monitor software at: Settings > Device > GNSS. There are also user-settable options for
how the GNSS satellites are used. The setting are available in the GNSS Tracking and GNSS
SBAS tabs. With the Help window open (accessed with the Help button), mousing over
context-sensitive settings provides a detailed explanation of the setting (Figure 17 GNSS Settings).
To view and record GNSS outputs, see Basic Setup and Operations on page 11.

Figure 17 - GNSS Settings
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Measurement

Units

Position (LLH)

degrees
(latitude, longitude)
meters
(height, accuracy)

Velocity (NED)

meters/second
(velocity, accuracy)

Heading (NED)

degrees

Speed

meters/second
(speed, accuracy)

Position (ECEF)

meters

Velocity (ECEF)

meters/second
(velocity, accuracy)

DOP Data

--

GPS Time

weeks & seconds

UTC Time

time and date

Clock Information
GNSS Fix
Information
Space Vehicle Information (SVI)

seconds

Hardware Status

--

DGPS Information
DGPS Channel Status

---

-N/A

Sensor Measurements

Description
position reported by GNSS module only,
expressed in latitude, longitude, and height
(LLH) with accuracy estimation. Height is
elevation or altitude relative to average sea
level (MSL reading) or height relative to WSG84 Ellipsoid (AE reading).
velocity measurement reported by
GNSS module, with reference to the NorthEast-Down coordinate system and with
accuracy estimation
heading reported by GNSS module, with
reference to the North, East, Down
coordinate system and with accuracy
estimation *
speed along direction of travel in 2D and 3D
space as reported by GNSS module only *
position reported by GNSS module, with
reference to the Earth Centered, Earth Fixed
(ECEF) Cartesian coordinate system
velocity reported by GNSS module, with
reference to the Earth Centered, Earth Fixed
(ECEF) Cartesian coordinate system
Dilution of Precision (DOP) ratings for
accuracy of GNSS readings
time acquired from the satellites
Coordinated Universal Time (UTC) to
fractional seconds with leap year seconds
adjustment and confidence indicator. Also
week number, month, date and year.
clock accuracy metrics
information about the type, quantity and
quality of the satellite connections
referred to as Satellite Info, includes satellite
number and signal strength
operational status of GNSS receiver and
antenna
individual satellite signal strength indicator
(future use)

*Output not available in MIP™ Monitor. Refer to the 3DM-GQ4™ MIP™ Data Communications Protocol manual

Table 5 - GNSS Outputs
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4.3

Sensor Measurements

Computed Outputs (Estimation Filter)

The computed outputs are measurements from the 3DM-GQ4-45™ IMU sensors and GNSS
receiver that are blended through an Extended Kalman Filter (EKF) algorithm. The Kalman
Filter produces a better estimation of position, velocity, and attitude (PVA) outputs than can be
achieved by the inertial sensors or the GNSS individually. This estimate is output at a higher
data rate than GNSS and is not subject to the integration errors inherent in an inertial-only
solution. Refer to Table 6 - Estimation Filter Outputs for a complete list of outputs.
In the MIP ™ Monitor software there are user-settable options for how the estimations are
made. These settings are available at: Settings > Device > EF. With the Help window open
(accessed with the Help button), mousing over context-sensitive settings provides a detailed
explanation of the setting (Figure 18 - Estimation Filter Settings).

Figure 18 - Estimation Filter Settings
All of the estimation filter outputs are available to view and record in MIP™ Monitor. In addition
to the standard position, velocity, attitude, and time (PVA&T) solution, additional filter outputs,
such as uncertainties, inertial sensor bias and scale factors, filter status, and physical models
(WGS84, WMM, and SAM) are available (Table 6 - Estimation Filter Outputs).
To view and record Estimation outputs, see Basic Setup and Operations on page 11.

28

3DM-GQ4-45™ Inertial Navigation System User Manual
Measurement

Units

Filter Status

--

GPS Time

weeks & seconds

Position (LLH)

degrees (position)
meters
(height, uncertainty)

Velocity (NED)

meters/second
(velocity, uncertainty)

Attitude
(Euler RPY)

radians

Attitude
(Matrix)

--

Attitude
(Quaternion)

--

Acceleration
(Linear and
Compensated)

meter/second2

Compensated
Angular Rate

radians/second

Gravity Vector

meter/second2

WSG-84 Local
Gravity Magnitude

meter/second2

Heading Update

radians

29

Sensor Measurements

Description
indicates the current state of the EF, such
as running or initializing
GNSS time corresponding to the calculated
filter solution
estimated position based on combined
sensors inputs and EF, expressed in latitude, longitude, and height (LLH) with
uncertainly estimation available
estimated velocity based on combined
sensor inputs and EF, with reference to the
North-East-Down coordinate system and
with uncertainty estimation available
Euler angles representation of
orientation expressed as roll, pitch and yaw
(RPY) with one-sigma uncertainly estimation available
transformation matrix that describes
orientation with reference to the Earth
Centered Earth Fixed (ECEF)
coordinate system
unit quaternions representation of
orientation with one-sigma uncertainly
estimation available
absolute or linear acceleration readings
with reference to either the sensor or
vehicle frame (depending on settings), with
bias and scale readings, and one-sigma
uncertainty estimations also available.
measured angular rate corrected using the
estimated gyroscope scale factor and bias,
with reference to either the sensor or
vehicle frame (depending on settings)
estimated WGS84 gravity vector with
reference to either the sensor or vehicle
frame (depending on settings)
local WGS84 gravity vector magnitude
heading used to update EF, calculated from
the selected heading source
(magnetometer, external, etc.) with

3DM-GQ4-45™ Inertial Navigation System User Manual
Measurement
WMM (World Magnetic Model)
Pressure Altitude
SAM
Antenna Offset
Error

Units
Gauss
meters (altitude)
meters (altitude)
pressure (milli-bars)
temperature (°C)
density (kg/m3)
meters

Sensor Measurements

Description
one-sigma uncertainty reading available
WMM local magnitude, inclination and
declination based on GNSS coordinates
altitude estimate from barometric pressure
altitude as derived from the U.S. Standard
Atmospheric Model (SAM) using the
sensed barometric pressure and air
temperature
filter-calculated error based on the usersupplied GNSS antenna offset

Table 6 - Estimation Filter Outputs
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4.4

Sensor Measurements

Sensor Reference Frames

4.4.1

Geodetic Frame

The World Geodetic System is the standard for cartography and navigation. The latest
revision, WGS84, is the reference coordinate system for GPS, and the 3DM -GQ4-45™
reports position using this coordinate frame. It also calculates the magnitude of the local
gravity vector using the WGS84 reference formulas.
The WGS coordinates are latitude (φ), longitude (λ), and height (h) above the reference
ellipsoid. Latitude ranges from -90 degrees at the South Pole to 90 degrees at the North
Pole. Longitude ranges from -180 to 180 degrees, with 0 degrees being the prime meridian.
The -180/180 degree switchover occurs in the middle of the Pacific Ocean and includes a
section of the International Date Line. The model takes into account the oblateness of the
Earth’s surface.
A point (P) on or above the Earth in the WGS84 coordinate system is notated as: latitude
(φ), longitude (λ), and height above the reference ellipsoid (h).

Figure 19 - World Geodetic System (WGS84) Reference Ellipsoid
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4.4.2

Sensor Measurements

North East Down (NED) Frame

The North-East- Down (NED) frame is a local coordinate frame, which is formed by a
tangent plane located at a particular point (current coordinates) on the WGS84 reference
ellipse. The NED frame is constructed with the (true) North vector along the line of
longitude, the East vector along the line of latitude, and the Down vector normal to and
towards the tangent plane (Figure 20 - North East Down Frame). The assumption when
using the NED frame is that the local surface can be reasonably approximated by a flat
plane. For most applications, this assumption is valid and provides a more intuitive reference
frame for expressing velocity and attitude information than a global frame.
The 3DM-GQ4-45™ reports velocity in this frame and attitude with respect to this frame.

Figure 20 - North East Down Frame
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4.4.3

Sensor Measurements

Sensor Frame

The sensor frame is indicated on the top of the device and is oriented such that the x-axis
vector is parallel with the long side of the sensor and points toward the sensor connector,
the y-axis is 90° to the right of the x-axis, and the z-axis goes through the bottom of the
sensor (outward). These axes were selected so that when the connector on the device is
pointed north and the device is upright and level, the sensor frame will match the NED frame
exactly, giving zero rotation.
The 3DM-GQ4-45™ reports acceleration, angular rate, delta-Theta, delta-velocity, inertial
sensor biases and corrections , and GNSS antenna offset error in this frame when no
sensor-to-platform frame transformation has been provided (see Platform Frame on page
34).
The orientation of the sensor frame with respect to the local NED frame can be viewed in
the MIP ™ Monitor software at: View > 3D Attitude menu. This window displays the
orientation of the sensor in relationship to north and shows measurement origination for
acceleration and angular rate. The view can be rotated for clicking, holding, and dragging
the image. Options for true north and magnetic north georeferences are available through
the magnetic declination correction setting at: Device Settings > EF settings > Geographic.
Refer to the 3DM-GQ4-45™ dimensional diagram for the location of the measurement origin
(see Reference Diagrams on page 73).

Figure 21 - Sensor Frame
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4.4.4

Sensor Measurements

Platform Frame

The 3DM-GQ4-45™ includes the option to define an orientation transformation and offset
distance from the sensor frame to a user-definable platform frame. This is useful when the
sensor cannot be mounted in the same location or orientation as the desired reference point
on the platform frame. The transformation from sensor to platform frame is defined with
Euler angles and is expressed as a rotation from the sensor frame to the platform frame.
The offset is the location of the origin of the platform reference frame with respect to the
origin of the sensor frame, expressed in the sensor frame.
In the following example (Figure 22 - Platform Frame Transformation) the user has defined
the desired reference point on the platform frame to be located at the front bumper of the
vehicle. In accordance with aircraft co-ordinate systems the platform frame is oriented with
the x-axis pointed in the forward direction of travel, the z-axis pointed down, and the y-axis
pointed towards the passenger side. The sensor has been mounted face down toward the
rear of the vehicle, two meters from vehicle reference location with no offset in the y-axis
and z-axis directions. The proper transformation in this example would be: 180 degrees roll,
0 degrees pitch, and 0 degrees yaw, with an offset of [+2, 0, 0] meters (listed as x,y,z).

Figure 22 - Platform Frame Transformation
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In the MIP™ Monitor software the transformation and offset settings are entered at: Settings
> Device > Estimation Filter > Mounting in the Mounting Orientation and Mounting Offset
fields (Figure 23 - Platform Frame Settings).

Figure 23 - Platform Frame Settings

The orientation transformation affects the following EF outputs (see Computed Outputs
(Estimation Filter) on page 28 ): attitude, position, linear and compensated acceleration,
compensated angular rate, and gravity vector. It also affects the following IMU outputs:
acceleration, angular rate, magnetic field vector, delta Theta, and delta velocity.
The offset affects the following EF output: position (LLH).
Transformed acceleration is expressed at the location of the sensor but within the platform
frame. For example, if the sensor is offset from the center of gravity (CG), and the platform is
undergoing a rotation, an acceleration (in addition to any linear acceleration of the CG) will
be sensed in accordance with the following formula: (tangent acceleration) = (angular rate)*
(distance from CG).
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5.

Performance Optimization

Performance Optimization
5.1

Magnetometer Calibration

Although the 3DM- GQ4- 45™ magnetometers are calibrated at the factory to remove any
internal magnetic influences in the device, measurements are still subject to influence from
external magnetic anomalies when the sensor is installed. These anomalies are divided into
two classes: hard iron offsets and soft iron distortions. Hard iron offsets are created by objects
that produce a magnetic field. Soft iron distortions are considered deflections or alterations in
the existing magnetic field. Ideally, these influences are mitigated by installing the sensor away
from magnetic sources, such as coils, magnets, and ferrous metal structures and mounting
hardware. However, often these sources are hard to avoid or hidden.
To mitigate this effect when using the 3DM -GQ4 - 45 ™ magnetometer to aid in heading
estimations, a field calibration of the magnetometer after final installation is highly
recommended. This can be accomplished using LORD MicroStrain® MIP™ Hard and Soft Iron
Calibration software. This software is included with the MIP™ Monitor Software Suite (see
Software Installation on page 12). The following are instructions for field calibrating the
magnetometers:
1. Connect and power-on the sensor as normal, and open the MIP™ Hard and Soft Iron
Calibration software.
2. Enter the Local Magnetic Field information (Figure 24 - Sensor Menu) for the sensor
to account for magnetic influences inherent to the sensor's geographic location on the
Earth. As needed, use the WMM on Web button to access a World Magnetic Model
calculator on the British Geographic Survey website. This site, and similar sites,
generate Local Magnitude F values based on latitude and longitude entries. In the
calculator solution, these values will be found in row MF, column F.

Figure 24 - Sensor Menu
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3. The sensor should automatically appear in the sensor list (Figure 24 - Sensor Menu).
If not, use the Refresh button to query it and then select the sensor.
4. Select the Arm Recording button next to Collect Data (Figure 25 - Collect Calibration
Data). The software will begin taking readings, as indicated by the points counter in
the graphing window. The maximum number of points is 1000, however 100 is
usually adequate. As the readings are taken, rotate the sensor or sensor platform in
all possible directions to get a complete profile of the baseline magnetic influences
throughout the sensor frame. Data points will appear on the graph in red. For mobile
sensor platforms, such as ground vehicles, move the platform as much as possible to
simulate actual use without exposing it to excessive magnetic sources (such as
driving over railroad tracks or near steel pilings). The intention is to get a baseline of
the platform in a neutral environment that still accounts for the platform itself in all
orientations. For stationary platforms the baseline may include significant magnetic
influences that will be present during operation.

Figure 25 - Collect Calibration Data
5. When all possible rotations are completed, select "Stop Streaming" next to Collect
Data, and then select Save Data to save the calibration data points on the host
computer (Figure 25 - Collect Calibration Data).
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6. Click the Spherical Fit or Ellipsoid Fit button, depending on the application. Spherical
Fit is often best for applications with calibration rotations restricted to a 2D plane: for
example, a ground vehicle or a boat, because it will not likely not be rotated on all
three axis. Ellipsoid Fit is generally a better correction when soft iron effects are
present but only if enough data points can be collected in all quadrants. If the range of
motion is restricted in one dimension, the Spherical Fit may be the best choice. If
there are enough points in all dimensions, the Ellipsoid Fit may be better. Generally, if
the Spherical and Ellipsoid Fits are close in the mean diameter, then the Ellipsoid Fit
will be the best choice.
7. Click Write Spherical Fit or Write Ellipsoid Fit accordingly. This will write the values to
the sensor memory.
8. Cycle power to the sensor when prompted, and then use the Refresh button, if
needed, to re-establish communication with the sensor.
9. Start a calibration verification by clicking the Start Streaming Data button next to
Verify Calibration (Figure 26 - Verify Calibration). Rotate the device in all orientations
in the same way as during calibration. When completed click the Stop Streaming
Data button next to Verify Calibration. The resulting data points should be on or near
the spherical grid. Hold the left mouse button and drag to rotate the image. The
mouse wheel can be used to zoom in and out. If the fit is not close, the sensor may
require re-calibration. If it is close, as shown, calibration and verification is complete.

Figure 26 - Verify Calibration
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5.2

Performance Optimization

Gyroscope Bias

Gyroscope biases (offsets) can be zeroed out to set a baseline value for the static home
position and conditions in the application. This should be done after sensor installation.
To set the gyroscope baseline, place the sensor or sensor platform in the desired home
position. Allow 2-3 minutes for the sensor to warm up and for the temperature to stabilize for
the best bias capture. Select Settings > Capture Gyro Bias (Figure 27 - Gyro Bias Capture).
The sensor must remain stationary for about twenty seconds while the outputs are being
measured. A status message will appear when the capture has been completed.

Figure 27 - Gyro Bias Capture

39

3DM-GQ4-45™ Inertial Navigation System User Manual

5.3

Performance Optimization

Heading Drift and Compensation

There are four options for the heading reference source: GNSS velocity, the magnetometer, an
external reference, or none. If the setting is an external reference, the user has to provide a
heading reference (for example, see GNSS External Receiver on page 55). If the setting is
none, the estimated heading will drift when little- or-no changes in velocity are sensed (e.g.
when stationary or traveling in the same direction at a constant velocity). If the setting is the
magnetometer, there will be no drift, but the accuracy will only be as good as the
magnetometer. If using GNSS velocity as a heading reference, the sensor (or sensor platform)
has to be moving, or there will be no heading reading. Moving the platform in a dynamic way will
assist in recapturing the heading.
To select between the heading sources in MIP™ Monitor select Settings > Device > Estimation
Filter > EF Options.

Figure 28 - Heading Source Setting
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Performance Optimization

Angular Rate and Acceleration Limits

The 3DM-GQ4-45™ angular rate and acceleration range depend on the sensors installed in the
device. Exceeding the specified range for either sensor will result in estimated state errors and
elevated uncertainties until the over-range event is corrected and the filter can resolve the
errors.

5.5

Bandwidth

When selecting sensor and estimation outputs to be recorded, communication bandwidth
considerations should be taken into account, especially when using RS232 serial
communications. Lower baud rates equate to lower communication bandwidth, which can be
consumed quickly by selecting a large number of measurements at high sample rates. Severely
overrunning the communication bandwidth can have adverse effects on the sensor
performance due to excessive processor usage. Most computer RS232 ports are limited to
115,200 baud even though the 3DM-GQ4-45™ is capable of running at 921,600 baud.

5.6

Platform Frame Transformation

The transformation from the sensor frame to the platform frame (see Platform Frame on page
34) should be defined to the highest angular accuracy possible. The easiest way to accomplish
this is to co-align the frames. If this is not possible, using a simple transformation (such as 90 or
180 degree rotations on a single axis) is preferred. For complex transformations between the
frames, a calibration should be performed or analysis from a model should be conducted.

5.7

GNSS Parameters

The GNSS receiver used in the 3DM-GQ4-45™ has a speed limitation of 500 meters/second in
accordance with the United States International Treaty in Arms Regulation (ITAR) restrictions.
To use the 3DM-GQ4 -45™ GNSS receiver, the external antenna must be connected and
positioned with unobstructed line of sight to the sky in order to achieve satellite lock. Operating
environment can also effect GNSS operation, and the device must be operated within
specifications.
GNSS outages should be kept to a minimum. As an outage period progresses, the errors in the
integration of the inertial sensors compound, causing the solution to quickly diverge. Position
errors grow exponentially, and velocity grows linearly with measured acceleration error, and
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attitude errors will grow linearly with estimated bias error. Monitoring uncertainty metrics during
GNSS outage conditions will provide an indication of the estimation accuracy.

5.8

GNSS Antenna Offset

GNSS antenna offset is the distance of the antenna from the GNSS receiver in the 3DM-GQ445™ . Errors in this offset affects the accuracy of the EKF position, velocity, and attitude
solutions. The MIP™ Monitor allows entry of the offset in the Settings > Device > Estimation
Filter > Mounting > Antenna Offset (Figure 29 - Antenna Offset).
For the best possible filter solution, the GNSS antenna offset should be defined to the highest
degree possible, preferably down to at centimeter. Inaccuracies become non-negligible at 2 to
3 centimeters. The user should strive to minimize this distance, as large offsets (tens of meters
or more) will result in position oscillation due to small orientation inaccuracies. For example, a 1
degree error in attitude with a 10 meter antenna offset would result in a position error of
approximately 0.17 meters. If the offset was only 1 meter, the position error would be 1.7 cm.

Figure 29 - Antenna Offset
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Vehicle Dynamics Mode

The vehicle dynamics mode setting adjusts the Kalman filter expectation of the vehicle’s
motion. By doing this, the filter is better able to account for the effects that different dynamic
platforms have on changes in GPS satellite pseudo-ranges. Each platform setting (portable,
automotive, airborne, and airborne-high g-force) have different velocity and altitude limitations.
In the MIP™ Monitor software this setting is found at: Settings > Device > Estimation Filter > EF
Options > Vehicle Dynamics Mode (Figure 30 - Vehicle Dynamics Setting).
Refer to the 3DM-GQ4-45™ Data Communications Protocol (DCP) for more information about
this setting.

Figure 30 - Vehicle Dynamics Setting
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Estimation Filter Operation

The 3DM-GQ4-45™ combines the information from a GNSS receiver and the IMU sensors to
calculate a navigation solution that incorporates the strengths of the individual systems while
minimizing their weaknesses.
The GNSS solution is bounded and typically very good, but it is susceptible to several error
sources. Due to the geometry of the satellite constellation, vertical position accuracy is typically
less than horizontal position accuracy. Additionally, errors from atmospheric and multipath
effects, as well as clock error, further degrade the accuracy of the solution. Arguably the largest
problem with a GNSS-only solution for navigation is that a single GNSS receiver cannot give
users the orientation of the platform unless the sensor coordinate frame is co-aligned with the
platform velocity vector. For a lot of applications, this assumption is too restrictive. For example,
the pitch of an aircraft typically does not match the angle the velocity vector makes with the
horizon. This occurs because the aircraft’s wings must be at an angle with the oncoming air to
generate lift. Making the assumption that the two values are the same and using the pitch angle
as an input to an autopilot is a mistake. In order to obtain the attitude of the vehicle, something
more is needed.
In a conventional Attitude and Heading Reference System (AHRS) several sources of error
exist when making attitude estimates. First, the algorithm assumes the acceleration vector is
dominated by Earth’s gravity, with only transient linear accelerations. When long- duration
linear accelerations are experienced, such as when an aircraft performs a sustained 2G turn,
the AHRS will report incorrect pitch and roll angles. This error is the direct result of the
assumption that the accelerometers are only sensing Earth’s gravity. A second source of error
occurs when the device attempts to measure the Earth’s magnetic field. This field is very weak
compared to the numerous magnetic anomalies typically found on platforms, or naturally
occurring close to the Earth’s surface. If the magnetic anomalies in the platform remain
constant with respect to the sensor (no translation or rotation between the two) they can be
compensated for by performing a hard iron and/or soft iron calibration of the magnetometers
internal to the 3DM -GQ4-45™ (see Magnetometer Calibration on page 36). The hard iron
calibration compensates for magnetic effects that cause offsets in the magnetic field (additive
effects). The soft iron calibration compensates for effects that cause a non-uniformity of the
magnetic field which results in an ellipsoidal distortion in the field. Non-constant and external
sources, such as those found when traveling through cities, cannot be compensated and may
cause large errors in the heading estimation. Transient errors can be suppressed when the
magnetometer readings are combined with information from the gyroscopes but only for
periods on the order of a few seconds. Longer duration anomalies will result in heading errors.
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A third source of error occurs when attempting to navigate between geographic way-points
expressed in latitude and longitude. This error is due to the difference between detecting
magnetic north, which is output by the AHRS sensor, and true north, which is used to define
lines of longitude. If the AHRS is always used in one geographical location, the user can correct
for this difference using a constant offset. If the AHRS is used over a wide range of longitude,
the magnetic declination must be calculated from a magnetic model or obtained from GNSS
subsystem which outputs this data. The greatest problem with an AHRS is that it is an attitudeonly device and requires a GNSS for position and velocity.
As a first attempt at an improved navigation solution, a user could get position and velocity from
a GNSS receiver and attitude from an AHRS. This is an acceptable solution for many
navigation problems, but is susceptible to the errors described above. A more accurate
estimation of position, velocity, and attitude can be found by fusing the data from these two
independent systems using a Kalman filter.
The 3DM-GQ4-45™ runs a loosely-coupled Extended Kalman Filter. In a loosely-coupled filter,
the inertial sensors in the IMU are used to propagate the state estimation at a high rate (500
Hz); whereas the GNSS position and velocity measurements are used to periodically correct
the state (4 Hz.) This form of Kalman filter is called a sensor fusion filter as it combines similar
information from multiple sources in a complementary way. This combination takes into
account the statistical properties of the sensors used, providing a better estimate of the true
state than either system individually. The 3DM-GQ4-45™ has a full-state dynamics model. The
state propagation utilizes Newton’s and Euler’s equations of motion with the acceleration and
angular rate treated as control inputs. In addition to the GNSS measurement, the IMU
magnetometer is available to correct heading mis-alignments which occur during periods of low
dynamics. The magnetometer corrections can be disabled for applications where large, nonconstant magnetic interference sources exist, which would impair their use (such as when
mounting the 3DM-GQ4-45™ on a gimbal close to the frame of a ground vehicle).
The Kalman filter estimates the full states of position, velocity, attitude, and sensor parameters
for a total of 25 states: 3 position, 3 velocity, 4 attitude (quaternion), 3 accel bias, 3 gyro bias, 3
accel scale factor, 3 gyro scale factor, and 3 GNSS antenna offset error states. The bias states
are estimated in order to compensate for the time-varying biases inherent in MEMS inertial
sensors, which are the largest error sources for these devices. The bias states are subtracted
from the gyroscope and accelerometer inputs, thus providing more accurate inertial data to the
propagation stage of the filter. This enhances overall accuracy and is especially useful during
GNSS outage conditions.
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The Kalman filter also provides statistical information about the quality of the estimated states
described in a covariance matrix. The diagonal terms of the matrix are the variance of each
state, thus the square root of these values are 1-sigma standard deviations. These values give
the filter’s estimation of how well it knows the individual states, given what it knows about the
statistical properties of the noise sources of the various sensors and also provide feedback to
the user as uncertainty values. The GNSS position and velocity noise are not white but are
treated as such in a loosely-coupled filter. This approximation results are not optimal, but the
advantages of this type of filter outweigh that disadvantage.

5.11

Estimation Filter Convergence

5.11.1

Initial Convergence

After a successful initialization, a period of convergence for the Kalman filter states occurs.
Position, velocity, roll angle, and pitch angle typically converge very quickly. Heading,
accelerometer bias, and gyro bias take more time to converge. If the initial attitude estimate
provided to the filter is well outside of the true attitude, the filter may diverge and never
recover. This is most likely to occur for the heading estimate when a poor value is used for
initialization and when the vibration environment is strong. Should this occur, it is
recommended that the filter be reset and new attitude estimate provided. Refer to the 3DMGQ4-45™ MIP™ DCP Manual for the various ways of providing an initial attitude estimate
through a user-designed interface.

5.11.2

Bias Convergence

Accurate estimation of the biases can take several minutes to converge, therefore after the
filter is initialized, the free- inertial performance will continue to improve until the bias
estimations settles. The MEMS sensor manufacturers quote bias drift stability numbers
which correspond to the expected drift in bias while the sensor is operating. The filter
attempts to track the changing biases over time, and a user can expect these bias estimates
will be non-constant during a navigation run.

5.11.3

Output Uncertainty

The 3DM-GQ4-45™ estimation data set includes a filter status field that contains a set of
status flags. These flags pertain to high covariance values for position, velocity, attitude, and
inertial sensor parameters. These flags should be monitored and cross-checked against the
corresponding uncertainty fields when they appear. This can assist in determining how
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trustworthy the solution generated by the Kalman filter is. When the filter is first initialized, it
is likely that some of these values will be beyond limits, and the flags may be asserted. This
fact should be taken into account when developing automated monitoring systems.

5.12

Vibration Isolation

The 3DM-GQ4-45™ should be isolated from strong vibrations a much as possible. Strong,
continuous vibrations appear as unaccounted noise to the estimation filter, degrading its
performance.

5.13

IMU Sensor Calibration

All of the internal sensors in the 3DM - GQ4 - 45 ™ are calibrated when the device is
manufactured, and the calibration values are saved in the device memory. With the exception
of the magnetometer field calibration (see Magnetometer Calibration on page 36) recalibration
is not required unless the device has been under conditions that exceed the operating
specifications. For example, if the sensor has been exposed to excessive shock beyond the
rated g-force, performance may be compromised. Indications of internal sensor damage may
be seen as measurement offsets or drift when the sensor is in a neutral motionless position.

5.14

Temperature Compensation

All sensor conversion and calibration formulas include temperature compensation. All
computed outputs and IMU sensor outputs are automatically adjusted for local temperature
(see Direct Sensor Measurements (IMU Outputs) on page 24 ).
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Sensor Installation
6.1

Sensor Mounting

The 3DM-GQ4-45™ sensor housing is rated for indoor use only, unless used inside a protective
enclosure. When using the internal GNSS receiver, the GNSS antenna connector on the side
of the sensor must be accessible.
The sensor has two mounting tabs with holes for fastening. There are two additional holes
used for precise alignment with 2mm dowel pins. One of the holes is slotted to allow for relaxed
pin positioning accuracy. The sensor can be mounted in any orientation, as required for the
application (see Sensor Reference Frames on page 31). The axes are labeled on the face of
the sensor for reference, and the sensor measurement origin is shown in the sensor
dimensional drawing (see Reference Diagrams on page 73).

Figure 31 - Mounting the Sensor
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Sensor Installation

GNSS Antenna Installation

The GNSS antenna cable is plugged into the non-magnetic SMA-to-MMCX adapter cable
supplied with the 3DM-GQ4-45™. The adapter cable is then plugged into the 3DM-GQ4-45™
housing (see Interface and Indicators on page 10). The GNSS antenna provided with the
starter kit can be mounted by adhering with double-sided mounting tape. Alternate antenna
and cables, as well as external GNSS and receivers, can be used with the 3DM-GQ4-45™
when appropriate for the application (see Alternate GNSS Equipment on page 55).
The antenna must be mounted with an unobstructed line of sight to the sky in order to establish
GNSS satellite links. This can be accomplished through a window or more optimally by placing
the antenna outdoors. Use the GNSS Monitor in the MIP ™ Monitor software to observe
satellite link strength during installation to optimize placement (see Global Navigation Satellite
System (GNSS) Outputs on page 26). For the most accurate GNSSreadings and EF outputs
the antenna position, with reference to the sensor, should be carefully measured and entered
as the Antenna Offset setting (see GNSS Antenna Offset on page 42).
When using GNSS antennas with magnetic bases, take care
to not bring the antenna in close proximity to the sensor either
in handling or in permanent installation, as it may disrupt the
magnetometers within the 3DM-GQ4-45™.

Figure 32 - GNSS Antenna
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7.

OEM System Integration

OEM System Integration

The 3DM-GQ4- 45™ starter kit comes with everything that is needed for sensor configuration,
operation, and data collection. However, many applications will require custom solutions because
of physical or environmental constraints, required sensor output processing, or for integration into
control systems that react to the sensor outputs. For these applications the 3DM-GQ4-45™ is
available as a stand-alone component with optional interface connectors. The communication
protocol used for configuring and acquiring sensor data and estimations outputs is available for
these applications as well.

7.1

Data Communications Protocol (DCP)

The LORD MicroStrain ® MIP ™ Data Communications Protocol includes all commands
available for controlling and acquiring data from the 3DM-GQ4-45™, including many that are
not available in the MIP ™ Monitor software. Programming is performed through a standard
serial interface program. The programming interface is comprised of setup and control
commands and a very flexible user-configurable data output format. The commands and data
are divided into four command sets and three data sets corresponding to the internal
architecture of the device. The protocol is packet-based. All commands, replies, and data are
sent and received as fields in a message packet. The packets have a descriptor- type field
based on their contents, so it is easy to identify if a packet contains commands, replies, or data.
The MIP ™ software developers kit (SDK) includes sample code and can be found on the
LORD MicroStrain® website Support page or by contacting Technical Support (see Technical
Support on page 64).
The LORD MicroStrain ® MIP ™ Data Communications Protocol describes each command
description, message syntax, and message option. It also provides examples, and can also be
found on the LORD MicroStrain® website or through Technical Support.
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7.1.1

OEM System Integration

Packet Builder

To expedite program development, a packet builder tool is included in the MIP™ Monitor
software. The packet builder allows users to send multiple packets to the 3DM-GQ4-45™
and view the resulting reply data.
Applicable protocol structure and design is described 3DM-GQ4-45™ MIP™ DCP Manual.
The manual can be found with software installation thumb-drive, on the LORD MicroStrain®
website Support page or by contacting Technical Support (see Technical Support on page
64).
To use the packet builder select Advanced > Packet Builder from the MIP™ Monitor main
window (Figure 33 - Packet Builder). The sensor must be in the Standard communications
mode to use this feature.

Figure 33 - Packet Builder
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7.1.2

OEM System Integration

Sensor Direct Mode

The MIP™ Monitor software can be used to put the sensor in a mode that allows direct
programmatic access to the internal Inertial Measurement Unit (IMU). The IMU has its own
processor and protocol commands and native data outputs from the individual IMU sensors
that may not be available in MIP™ Monitor.
When in Sensor Direct mode the device normal functionality is not available. The protocol
commands used to interface with the IMU are a subset of the standard LORD MicroStrain®
MIP™ Data Communications Protocol and are further described in the LORD MicroStrain®
MIP™ Data Communications Protocol manual. For additional information contact LORD
MicroStrain® Technical Support (see Technical Support on page 64).
To enter this mode select Advanced > Communications> Sensor Direct from the
MIP™ Monitor main window. Once in this mode the device status message will indicate
Sensor Direct Mode (Figure 34 - Sensor Direct Mode).
To exit Sensor Direct Mode select the Refresh button in the MIP™ Monitor at any time, or
use Advanced > Communication menu to select the Standard operating mode.

Figure 34 - Sensor Direct Mode
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7.1.3

OEM System Integration

GNSS Direct Mode

The MIP™ Monitor software can be used to put the sensor in a mode wherein direct access
to the internal GNSS receiver is available. In this mode the 3DM - GQ4 - 45 ™ normal
functionality is not available, and protocol commands cannot be used. This mode is called
GPS Direct mode and is used to allow communication with the receiver through an external
utility program available from the GNSS receiver manufacturer (such as u- blox) or by
contacting LORD MicroStrain ® Technical Support (see Technical Support on page 64).
Also refer to the Using u- blox Software Technical Note for specific instructions ( see
Reference Documents on page 77).
To start communicating with the GNSS receiver in GPS Direct mode, select Advanced >
Communication > GNSS Direct from the MIP™ Monitor main window. Once in this mode
the device status message will indicate "GNSS Direct Mode" (Figure 35 - GNSS Direct
Mode).

Figure 35 - GNSS Direct Mode
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7.2

OEM System Integration

Sensor Wiring
Only use power supplies within the operating range of the
sensor, or permanent sensor damage or personal injury could
result. There are two input power pins available, each with
different voltage ranges. Connect only one at a time. Observe
connection polarity.

Sensor power and serial communications cables are available from LORD MicroStrain® and
come with the sensor starter kits. These cables will have the micro-DB9 connector on one end
(to connect to the sensor) and either a standard DB9 on the other end (for RS232
communication) or a USB connector (for USB communications). Alternately, the micro-DB9
can be purchased from LORD MicroStrain® with flying leads or the connector by itself can be
purchased from the manufacturer (Ulti-Mate Connector Inc.). See Parts and Configurations on
page 66 for a list of available options.a standard DB9 on the other end. For the cable diagram
see Reference Diagrams on page 73.
The connector interface includes connections for USB and RS232 communications (only
connect one), two options for sensor input power range (only connect one), and a precision
hardware timing output (PPS output) for synchronizing with external timestamps. The sensor
selects the appropriate serial communication (USB or RS232) on power-up based on which
connection is used.

Figure 36 - Connector Wiring
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7.3

OEM System Integration

Alternate GNSS Equipment

Other (external) GNSS receivers, antennas, and/or cables can be used with the 3DM-GQ445™. When using third party antennas, it is important to use a broadband GNSS antenna
designed for receiving GPS, GLONASS, and BeiDou frequencies. Using a GPS only antenna
will degrade performance. Additionally, the antenna cable length, antenna gain, and antenna
power must be considered. For antennas with internal LNA (Low Noise Amplifiers) the power
requirements should not have a minimum voltage below 3 volts, and the current draw should
not be over 20mA. The longer the cable, the lower the signal strength, and including the
antenna cable offset in GNSS outputs is advised (see GNSS Antenna Offset on page 42). The
loss of signal strength can only be empirically determined by trying out a particular installation
and monitoring the number of satellite links and quality of data reception from those satellites.
This can be done with the MIP™ Monitor software (see Global Navigation Satellite System
(GNSS) Outputs on page 26).
When using a different GNSS antenna, always use the non-magnetic MMCX-to-SMA adapter
supplied with the 3DM-GQ4-45™ unless the magnetometer is not used in the end application.

7.3.1

GNSS External Receiver

To use an external GNSS receiver, the internal receiver must be disabled, and a serial link
established between the receiver and the sensor through the host computer. A program is
then written using the LORD MicroStrain® MIP™ Data Communications Protocol to port the
data from the GNSS input via the host to the sensor serial port and to translate the
GNSS receiver data into the message structure the sensor processor can interpret. The
data cannot be sent any faster than 20 Hz.
To set the GNSS receiver to external, open the Device Settings menu in the MIP™ Monitor
software by right- clicking on the sensor name in the main window ( Figure 37 GNSS Source Select). Select the Estimation Filter tab and then EF Options. Set the GPS
Update Source to External GPS .
Test external GNSS messaging using the Advanced > GPS External Input interface. This
command will send a fixed external GNSS message to the device and mimic a pulse-persecond clock input (Figure 38 - External GNSS Data).
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Figure 37 - GNSS Source Select

Figure 38 - External GNSS Data
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7.4

OEM System Integration

Sampling on Start-up

The Save Current Settings command can be used to instruct the sensor to start streaming data
as soon as it powered on. This can be useful in sensor integration applications in which
immediate data acquisition is desired, and connection to MIP™ Monitor for data logging is not
required. This functionality can also be embedded in user-designed applications by using the
corresponding LORD MicroStrain® MIP ™ Data Communications Protocol command ( see
Data Communications Protocol (DCP) on page 50 for more information).

NOTE
When setting the sensor to begin sampling on start-up, verify that the sensor is
sampling by viewing the serial data stream from the host computer. If
communication with MIP™ Monitor is established, the sampling will stop to
facilitate device configuration.

To save the current sensor configuration, first adjust the sensor settings to the desired values,
and then start streaming. Next select Settings > Save Current Settings from the main window
(Figure 39 - Save Sensor Settings). The setting will remain intact when the sensor is powered
off and then on again.
To recall the last saved settings select Settings > Load Startup Settings.

Figure 39 - Save Sensor Settings
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7.5

OEM System Integration

Connecting to a Datalogger

Many inertial applications incorporate dataloggers of all different types to collect and distribute
sensor outputs. For more information and examples refer to the "Using Dataloggers with
Inertial Sensors" Technical Note on the LORD MicroStrain ® website, or contact LORD
MicroStrain® Technical Support (see Technical Support on page 64).
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8.

Troubleshooting
8.1
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Problem

Troubleshooting

Possible cause and recommended solution
1.1 no power is applied

1. POWER
sensor does not power
on

The status indicator on the device will be off. Make sure the
sensor is connected to a power source and the status indicator
illuminates.
1.2 power source is off or miswired
Verify the device power source is connected correctly.
1.3 power supply is the wrong voltage
Using a power supply other than the one provided with the
device, or a supply that is outside of the device operating range,
could result in permanent damage or cause it to not work
properly.
1.4 sensor is in firmware update mode
Firmware update mode is used when updating firmware on the
device. If the firmware updater fails, it is possible that the device
can get stuck in the firmware update mode, and the sensor will
be non- responsive. Contact LORD MicroStrain ® Technical
Support (See Technical Support on page 64).
1.5 sensor is damaged
If all power settings and connections have been verified, and
the sensor is still unresponsive, contact LORD MicroStrain ®
Technical Support (See Technical Support on page 64).
2.1 sensor not found in MIP™ Monitor

2. COMMUNICATION
no communication to
sensor or GPS receiver

In MIP™ Monitor use the Refresh button to look for the sensor
again. If the sensor is still not found try cycling power to the
sensor and refreshing.
2.2 communication cable not connected or miswired
Check, remove, and reconnect communications and power
cables as applicable. Replace or rewire as needed.
2.3 device drivers not installed
Verify the drivers (included with MIP™ Monitor Software Suite)
are installed on the computer and that the software has had
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Problem

Troubleshooting

Possible cause and recommended solution
sufficient time to detect it. See Software Installation on page 12
2.5 GNSS receiver is not communicating
The GNSS antenna requires unobstructed line of sight to the
sky in order to link with the GNSS satellites. Also verify the
GNSS antenna is plugged into the sensor and the cable is
intact. Verify the GNSS source setting is set for an internal or
external device as applicable. When using an external receiver,
a receiver-to-serial translation program that utilizes the LORD
MicroStrain® MIP™ Data Communications Protocol is required
to provide the GNSS data to the sensor.
2.5 sensor or cables are damaged
Verify all connections, power, and settings. If available, try
installing an alternate cable or sensor one at a time to see if the
faulty device can be identified. If no conclusion can be
determined, or to send a device in for repair, contact LORD
MicroStrain ® Technical Support ( See Technical Support on
page 64).
3.1 sampling settings are incorrect

3. DATA ACQUISITION
sensor data is missing
or incorrect

If unexpected measurements or sampling rates are displayed
or recorded, enter the Device Settings menu and verify the
sampling settings.
3.2 streaming has not started
If data streaming is occurring the sensor device status indicator
will also be flashing to indicate sampling. In MIP™ Monitor the
device status information field will indicate Streaming. If the
sensor is not streaming data, activate it in the software.
3.3 heading data incorrect
If the magnetometers have not been field-calibrated, erroneous
heading data could result. If the GNSS antenna offset has not
been entered, or the GNSS receiver or satellite link is not
activated, it could also skew heading information.
3.4 sensor data not recorded
Verify data recording has been activated. In MIP™ Monitor the
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Problem

Troubleshooting

Possible cause and recommended solution
device status information field will indicate Recording Data. If
the sensor isn't recording, activate in the software. Verify
specific measurements have been enabled for sampling and
recording.
NOTE:Data is recorded in time sequence. If measurements
are set to different sample rates, not all time intervals will
include a reading from each output that is being recorded.
3.5 sensor data recorded in binary format
When data recording is started the user can choose between
CSV and Binary output formats. If the data is recorded in
Binary format it will require a translation program that utilizes
the LORD MicroStrain® MIP™ Data Communications Protocol
to make it readable.
3.6 sensor has been magnetized
Contact or close proximity with magnets may disrupt the sensor
operation and cause magnetization of internal components,
which can affect magnetometer performance. If magnetization
is suspected, use a degaussing tool to demagnetize.
3.7 sensor is damaged
With the sensor in a static neutral position data, look for
baseline offset or drift on the IMU sensor outputs. Sensor
damage can occur as a result of excessive g- force other
conditions outside of its operating specifications.
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8.2

Troubleshooting

Repair and Calibration
General Instructions
In order to return any LORD MicroStrain® product, you must contact LORD
MicroStrain® Sales or Technical Support to obtain a Return Merchandise
Authorization (RMA) number. All returned merchandise must be in the original
packaging, including manuals, accessories, cables, etc. with the RMA number
clearly printed on the outside of the package. Removable batteries should be
removed and packaged in separate protective wrapping. Please include the
LORD MicroStrain® model number and serial number, as well as your name,
organization, shipping address, telephone number, and email. Normal turnaround for RMA items is seven days from receipt of item by LORD
MicroStrain®.
Warranty Repairs
LORD MicroStrain® warrants its products to be free from defective material
and workmanship for a period of one (1) year from the original date of
purchase. LORD MicroStrain ® will repair or replace, at its discretion, a
defective product if returned to LORD MicroStrain® within the warranty period.
This warranty does not extend to any LORD MicroStrain® products that have
been subject to misuse, alteration, neglect, accident, incorrect wiring, misprogramming, or use in violation of operating instructions furnished by LORD
MicroStrain® . It also does not extend to any units altered or repaired for
warranty defect by anyone other than LORD MicroStrain®.
Non-Warranty Repairs
All non- warranty repairs/replacements include a minimum charge. If the
repair/replacement charge exceeds the minimum, LORD MicroStrain ® will
contact the customer for approval to proceed beyond the minimum with the
repair/replacement.
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8.3

Troubleshooting

Technical Support

There are many resources for product support found on the LORD MicroStrain ® website
including technical notes, FAQs, and product manuals.
http://www.microstrain.com/support_overview.aspx

For further assistance our technical support engineers are available to help with technical and
applications questions.

Technical Support
sensing_support@LORD.com
Phone: 802-862-6629
Fax: 802-863-4093
SKYPE: microstrain.orientation.support
Live Chat is available from the website during business hours:
9:00 AM to 5:00 PM (Eastern Time US & Canada)
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9.

Maintenance

Maintenance
There are no user-serviceable parts on the 3DM-GQ4-45™. Removing the device cover or
disassembling in any way voids the product warranty.
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10.

Parts and Configurations

Parts and Configurations

10.1

Standard Configurations

For the most current product information, custom, and OEM options not listed below, refer to
the LORD MicroStrain® website or contact the LORD MicroStrain® Sales Department.
Table 7 - Model Numbers describes the standard models available at the time this manual was
published. Once a model is selected, the part number is further defined by desired configuration
and interface options. The model determines the first four digits of the product part number; the
options are indicated in the last four digits (Figure 40 - Standard Part Numbers).

Table 7 - Model Numbers
The same options are available in each model, and are indicated in the last four digits of the
product part number. For a list of the starter kit contents, see Components on page 9.
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Parts and Configurations

Figure 40 - Standard Part Numbers

Description

LORD MicroStrain®
Part Number

3DM-GQ4-45 sensor only (standard, +/-5g, 300°/sec)
3DM-GQ4-45 Starter Kit (USB, +/-5g, 300°/sec)
3DM-GQ4-45 Starter Kit (USB, +/-5g, 900°/sec)

6250-4220
6250-4241
6250-4741

Table 8 - Example Part Numbers
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10.2

Parts and Configurations

Accessories

The following parts are available for use with the 3DM-GQ4™, and some are included in sensor
starter kits (see Components on page 9). For the most current product information refer to the
LORD MicroStrain® website or contact the Sales Department. See Sales Support on page 69.

Description

LORD MicroStrain®
Part Number

RS232 communications cable
USB communications cable
Power supply (RS232 systems only)
Power supply country plug adapter kit (RS232 systems only)
GNSS dual feed antenna with 3m cable, SMA connector
Antenna cable adapter MMCX to SMA
MIP™ Monitor Software Suite flash drive
Sensor mating connector (micro-DB9) with flying leads

4005-0037
9022-0019
9011-0009
9011-0022
9010-0150
9022-0032
8200-0020
6224-0100

Table 9 - Sensor Accessories

Description

Manufacturer
part number

“A” Series or “P” Series 9-pin male Micro-D connector

Ulti-Mate PR09N05

Table 10 - Sensor Mating Connector
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10.3

Parts and Configurations

Sales Support

Products can be ordered directly from the LORD MicroStrain® website by navigating to the
product page and using the Buy feature.
http://www.microstrain.com/inertial
For further assistance, our sales team is available to help with product selection, ordering
options, and questions.

Sales Support
sensing_sales@LORD.com
Phone: 802-862-6629
Fax: 802-863-4093

9:00 AM to 5:00 PM (Eastern Time US & Canada)
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11.

Specifications

Specifications
General
Triaxial accelerometer, triaxial gyroscope, triaxial
magnetometer, temperature sensors, pressure altimeter, and
GNSS receiver

Integrated sensors

Inertial Measurement Unit (IMU) outputs: acceleration,
angular rate, ambient pressure, deltaTheta, deltaVelocity
Computed outputs:
Extended Kalman Filter (EKF): filter status, GNSS
timestamp, LLH position, NED velocity, attitude estimates (in
Euler angles, quaternion, orientation matrix), bias
compensated angular rate, pressure altitude, gravity-free
linear acceleration, gyroscope and accelerometer bias, scale
factors and uncertainties, gravity and magnetic models, and
more. Complementary Filter (CF): attitude estimates (in
Euler angles, quaternion, orientation matrix), stabilized north
and gravity vectors, GNSS correlation timestamp

Data outputs

Global Navigation Satellite System outputs (GNSS): LLH
position, ECEF position and velocity, NED velocity, UTC
time, GNSS time, SV.GNSS protocol access mode available.
Inertial Measurement Unit (IMU) Sensor Outputs
Accelerometer

Gyroscope

Magnetometer

Measurement range

±5 g

300°/sec
(standard)
±75, ±150, ±900
°/sec (options)

±2.5
Gauss

Non-linearity

±0.03 % fs

±0.03 % fs

±0.4 % fs

Resolution

<0.04 mg

<0.0025°/sec

--

Bias instability

±0.02 mg

5°/hr

--

Initial bias error

±0.001 g

±0.05°/sec

±0.003 Gauss

Scale factor stability

±0.05 %

±0.05 %

±0.1 %

Noise density

50 µg/√Hz

0.002°/sec/√Hz

100 µGauss/√Hz

Alignment error

±0.05°

±0.05°

±0.05°

Adjustable bandwidth

250 Hz (max)

160 Hz (max)

-

Vibration induced noise
Vibration rectification error (VRE)

IMU filtering

0.06°/s RMS/g
--RMS
2
0.001°/s/g
0.03%
-RMS
4 stage filtering: analog bandwidth filter to digital sigma-delta
wide band anti-aliasing filter to (user adjustable) digital
averaging filter sampled at 8 kHz and scaled into physical
units; coning and sculling integrals computed at 1 kHz

Sampling rate

10 kHz

IMU data output rate

1 Hz to 500 Hz
Pressure Altimeter
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Range

-1800 m to 10,000 m

Resolution

< 0.1 m

Noise density

0.01 hPa RMS

Sampling rate

10 Hz

10 kHz

50 Hz
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Computed Outputs
Position accuracy

±2.5 m RMS horizontal, ± 5 m RMS vertical (typ)

Velocity accuracy

±0.1 m/s RMS (typ)

Attitude accuracy

±0.1° RMS roll & pitch, ±0.5° RMS heading (typ)

Attitude heading range

360° about all axes

Attitude resolution

< 0.01°

repeatability

0.1° (typ)

Calculation update rate

500 Hz

Computed data output
rate

1 Hz to 500 Hz

Global Navigation Satellite System (GNSS) Outputs
Receiver type

72-channel GPS/QZSS L1 C/A, GLONASS L10F, BeiDou B1,
SBAS L1 C/A:WAAS, EGNOS, MSAS Galileo-ready E1B/C

GNSS data output rate

1 Hz to 4 Hz

Time-to-first-fix

Cold start: 27 sec, reacquisition: 1 sec
hot start: <1 sec

Sensitivity

Tracking: -164 dBm, cold start: -147 dBm,
hot start: -156 dBm

Velocity accuracy

0.1 m/sec

Heading accuracy

0.5°

Horizontal position
accuracy

GNSS: 2.5 m CEP (autonomous)
SBAS: 2.0 m CEP (stationary, 24 hours, SEP 3.5 m)

Time pulse signal
accuracy

30 nsec RMS
< 60 nsec 99%

Acceleration limit

≤ 4g

Altitude limit

No limit

Velocity limit

500 m/sec (972 knots)

Communication

USB
2.0
(full
speed)
RS232 (9,600 bps to 921,600 bps, default 115,200)

Power source

+ 4.2 to + 28 V dc

Power consumption

2.5 W (typ)

Operating temperature

-40 °C to +85 °C

Vibration limit

6 g RMS, 10 Hz to 2 kHz

Mechanical shock limit

750 g (half-sine, 2 msec powered, any axis)

Dimensions

76.2 mm x 65.4 mm x 18.9 mm

Weight

105 grams

Regulatory compliance

ROHS, CE, FCC Class B

Connectors

Data/power output: micro-DB9
GNSS antenna: MMCX type

Operating Parameters

Physical Specifications

Integration

Software
Compatibility
Software development kit
(SDK)
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MIP™ Monitor, MIP™ Hard and Soft Iron Calibration, Windows
XP/Vista/7/8 compatible
Protocol compatibility with 3DM-RQ1-45™, 3DM-GX3® and
3DM-GX4® sensor families
MIP™ data communications protocol with sample code
available (OS and computing platform independent)

Specifications
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12.

Safety Information

Safety Information

This section provides a summary of general safety precautions that must be understood and
applied during operation and maintenance of components in the LORD MicroStrain ® Inertial
Sensor Products. Throughout the manual, ANSI Z535 standard safety symbols are used to
indicate a process or component that requires cautionary measures.

Situations in which potentially hazardous conditions exist
that could result in death or serious injury of workers and/or
the general public if not avoided.
Situations where a non- immediate or potential hazard
presents a lesser threat of injury that could result in minor or
moderate injury to workers and/or the general public.
Situations where a non- immediate or potential hazard
presents a risk to damage of property and equipment. May
be used to indicate important operational conditions.

12.1

Disposal and Recycling

The 3DM-GQ4™ contains internal printed circuit boards
and electronic components. These items are known to
contain toxic chemicals and heavy metals that are
harmful to humans health and the environment. Disposal
is subject to federal and local laws. Do not discard the
device in the trash. Follow proper electronic waste
disposal protocol, as dictated by federal and local
authorities. Some states also have programs for
extracting reusable parts for recycling.
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13.

Addendum

Addendum

13.1

Reference Diagrams

The diagrams in this section are to intended to aid in product installation and troubleshooting.
For more information contact LORD MicroStrain® Technical Support (see Technical Support
on page 64).

13.1.1

Sensor Dimensions and Origin

This diagram describes the sensor physical specification including the measurement point of
origin.

Figure 41 - 3DM-GQ4™ Sensor Origin
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13.1.2

Addendum

GNSS Antenna Specifications

These specifications describe the GNSS antenna included in the 3DM-GQ4™ starter kit.

Physical Specifications
Construction

ASA plastic

Dimensions

38 mm x 38 mm x 14.3 mm

Weight

50 g (without cable and connector)

Standard mounting

adhesive, such as double-side tape

Cable

3 m RG174 (standard)

Connector

SMA straight 180 male

Environmental

IP67

Shock

50 g (vertical axes), 30 g (other axes)

Vibration

3 g (3 axis sweep, 15 min., 10 to 200 Hz sweep)
Overall Performance

Center Frequency

1582.5 MHz

Gain

26 dB (minimum)

Noise figure

1.0 dB (typical)

VSWR

< 1.5:1 (at LNA output)

Output impedance

50 ohm

Operating temperature

-40 °C to ~+85 °C

Architecture

Wideband dual feed patch element

Polarization

RHCP (Right Hand Circular Polarization)

Antenna Element

Axial ratio

< 2 dB (typical), 3 dB (max), over full bandwidth
Low Noise Amplifier
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Gain

4.5 dBic @1582.5 MHz (with 100 mm ground plane)

Bandwidth

1559 MHz to 1606 MHz

Noise figure

1.0 dB (typical)

Supply voltage

1.8
to
16
V
dc
(12 V dc recommended maximum)

Current consumption

10 mA (typical)

3DM-GQ4-45™ Inertial Navigation System User Manual

13.1.3

Addendum

Power Supply Specifications (RS232 kits only)

The power supply is only required for the RS232 devices. These specifications describe the
power supply included in the 3DM-GQ4™ starter kit.

Operating Parameters
AC input voltage rating

100 to 240 V ac

AC input voltage range

90 to 264 V ac

AC input frequency range

47 to 63 Hz

AC input current

0.25 A (RMS) maximum @ 120 V ac
0.125 A (RMS) maximum @ 240 V ac

Leakage current

0.25 mA maximum @ 254 V ac

Inrush current
(cold start @ 25 °C)

< 30 A for 120V ac @ maximum load
< 60 A for 240 V ac @ maximum load

Input power saving
(at no load)

0.3 W maximum

DC voltage rating

9 V dc

DC load capacity

0.56 A maximum

Ripple

90 mV peak to peak maximum

Regulation

± 5 % line and load

Efficiency

≥ 72.3 % average

Circuit protection

> 120 %, auto restart

Safety approvals

cUL/UL, TUV, SAA, CE, C-Tick, GS, EISA, N136
Environmental Parameters

Operating temperature

0 °C to +40 °C

Storage temperature

-25 °C to +85 °C

Humidity

10 to 90 %

Emissions

FCC Class B, EN55022 Class B

Dielectric withstanding (hipot) test

primary to secondary: 3000 V ac
Physical Specifications
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Dimensions

71.7 mm x 45 mm x 28.9 mm

Weight

120 g

DC output connector

2.1 mm x 5.5 mm center positive standard

Mating connector

Kycon KLD-0202-A or equivalent
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Communication and Power Cables

These diagrams describe the cables included in the 3DM-GQ4™ starter kits. Only one is
included in each kit, depending on the type of kit ordered.

Figure 42 - Communications and power cable (RS232 Kits, PN: 4005-0037)

Figure 43 - Communications cable (USB Kits, PN: 9022-0019)
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Figure 44 - Connecter interface cable (sold separately, PN: 6224-0100)

13.2

Reference Documents

Many references are available on the LORD MicroStrain ® website including product user
manuals, technical notes, and quick start guides. These documents are continuously updated
and may provide more accurate information than printed or file copies.

Document

Where to find it

3DM-GQ4-45™ Software Developers Kit

http://www.microstrain.com/softwaredevelopment-kits-sdks
http://www.microstrain.com/support/docs
http://www.microstrain.com/support/docs
http://www.microstrain.com/applications
http://www.microstrain.com/lordmicrostrain-inertial-sensors-all-products
http://www.nist.gov/calibrations/
http://www.astm.org/Standard/standardsand-publications.html

3DM-GQ4-45™ MIP™ DCP Manual
Product Technical Notes
Product Application Notes
Product Datasheets
NIST Calibration Procedures
ASTM Testing Procedures

Table 11 - Document Resources
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Glossary

A
A/D Value
The digital representation of analog voltages in an analog-to-digital (A/D) conversion. The
accuracy of the conversion is dependent on the resolution of the system electronics. Higher resolution produces a more accurate conversion.
Acceleration
In physics,acceleration is the change in the rate of speed (velocity) of an object over time.
Accelerometer
A sensor used to detect and measure magnitute and direction of an acceleration force (g-force)
in reference to its sensing frame. For example, at rest perpendicular to the Earth's surface an
accelerometer will measure 9.8 meters/second squared as a result of gravity. If the device is
tilted the acceleration force will change slightly, indicating tilt of the device. When the accelerometer is moving it will measure the dynamic force (including gravity).
Adaptive Kalman Filter (AKF)
A type of Extended Kalman Filter (EKF) that contains an optimization algorithm that adapts to
dynamic conditions with a high dependency on adaptive technology. Adaptive technology
refers to the ability of a filter to selectively trust a given measurement more or less based on a
trust threshold when compared to another measurement that is used as a reference. Sensors
that have estimation filters that rely on adaptive control elements to improve their estimations
are refered to as an AKF.
AHRS (Attitude and Heading Reference System)
A navigation device consisting of sensors on the three primary axes used to measure vehicle direction and orientation in space. The sensor measurements are typically processed by an
onboard algorthim, such as an Estimation Filter, to produce a standardized output of attitude
and heading.
Algorithm
In math and science, an algorithm is a step-by-step process used for calculations.
Altitude
the distance an object is above the sea level
Angular rate
The rate of speed of which an object is rotating. Also know as angular frequency, angular
speed, or radial frequency. It is typically measured in radians/second.

78

3DM-GQ4-45™ Inertial Navigation System User Manual

Addendum

API (Applications Programming Interface)
A library and/or template for a computer program that specifies how components will work
together to form a user application: for example, how hardware will be accessed and what data
structures and variables will be used.
ASTM (Association of Standards and Testing)
a nationally accepted organization for the testing and calibration of technological devices
Attitude
the orientaion of an object in space with reference to a defined frame, such as the North-EastDown (NED) frame
Azimuth
A horizontal arc measured between a fixed point (such as true north) and the vertical circle
passing through the center of an object
B
Bias
A non-zero output signal of a sensor when no load is applied to it, typically due to sensor imperfections. It is also called offset.
C
Calibration
to standardize a measurement by determining the deviation standard and applying a correction, or calibration, factor
Complementary Filter (CF)
A term commonly used for an algorithm that combines the readings from multiple sensors to
produce a solution. These filters typically contain simple filtering elements to smooth out the
effects of sensor over-ranging or anomalies in the magnetic field.
Configuration
A general term applied to the sensor indicating how it is set up for data acquisition. It includes
settings such as sampling rate, active measurements, measurement settings, offsets, biases,
and calibration values
Convergance
when mathematical computations approach a limit or a solution that is stable and optimal.

79

3DM-GQ4-45™ Inertial Navigation System User Manual

Addendum

D
Data Acquisition
the process of collecting data from sensors and other devices
Data Logging
the process of saving acquired data to the system memory, either locally on the device, or
remotely on the host computer
Data rate
the rate at which sampled data is transmitted to the host
Delta-Theta
the time integral of angular rate expressed with refernce to the device local coordinate system,
in units of radians
Delta-velocity
the time integral of velocity expressed with refernce to the device local coordinate system, in
units of g*second where g is the standard gravitational constant
E
ECEF (Earth Centered Earth Fixed)
a reference frame that is fixed to the earth at the center of the earth and turning about earth's
axis in the same way as the earth
Estimation Filter
A mathematical algorithm that produces a statistically optimum solution using measurements
and references from multiple sources. Best known estimation filters are the Kalman Filter,
Adaptive Kalman Filter, and Extended Kalman Filter.
Euler angles
Euler angles are three angles use to describe the orientation of an object in space such as the
x, y and z or pitch; roll; and yaw. Euler angles can also represent a sequence of three elemental
rotations around the axes of a coordinate system.
Extended Kalman Filter (EKF)
Used generically to describe any estimation filter based on the Kalman Filter model that can
handle non-linear elements. Almost all inertial estimation filters are fundamentally EKFs.
G
GNSS (Global Navigation Statellite System)
a global network of space based statellites (GPS, GLONASS, BeiDou, Galileo, and others)

80

3DM-GQ4-45™ Inertial Navigation System User Manual

Addendum

used to triangulate position co-ordinates and provide time information for navigational purposes
GPS (Global Positioning System)
a U.S. based network of space based statellites used to triangulate position co-ordinates and
provide time information for navigational purposes
Gyroscope
a device used to sense angular movements such as rotation
H
Heading
an object's direction of travel with reference to a co-ordinate frame, such as lattitude and longitude
Host (computer)
The host computer is the computer that orchestrates command and control of attached devices
or networks.
I
IMU
Inertial Measurement System
Inclinometer
device used to measure tilt, or tilt and roll
Inertial
pertaining to systems that have inertia or are used to measure changes in inertia as in angular
or linear accelerations
INS (Inertial Navigation System)
systems that use inertial measurements exclusively to determine position, velocity, and attitude,
given an initial reference
K
Kalman Filter
a linear quadratic estimation algorithm that processes sensor data or other input data over time,
factoring in underlying noise profiles by linearizing the current mean and covariance to produces an estimate of a system’s current state that is statistically more precise than what a single
measurement could produce
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L
LOS (Line of Sight)
Describes the ideal condition between transmitting and receiving devices in a wireless network.
As stated, it means they are in view of each other with no obstructions.
M
Magnetometer
A type of sensor that measures the strength and direction of the local magnetic field with
refernce to the sensor frame. The magnetic field measured will be a combination of the earth's
magnetic field and any magnetic field created by nearby objects.
MEMS (Micro-Electro-Mechanical System)
The technology of miniaturized devices typically made using micro fabrication techniques such
as nanotechnology. The devices range in size from one micron to several millimeters and may
include very complex electromechanical parts.
N
NED (North-East-Down)
A geographic reference system
O
OEM
acronym for Original Equipment Manufacturer
Offset
A non-zero output signal of a sensor when no load is applied to it, typically due to sensor imperfections. Also called bias.
Orientation
The orientaion of an object in space with reference to a defined frame. Also called attitude.
P
Pitch
In navigation pitch is what occurs when vertical force is applied at a distance forward or aft from
the center of gravity of the platform, causing it to move up or down with respect to the sensor or
platform frame origin.
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Position
The spatial location of an object
PVA
acronym for Position, Velocity, Attitude
Q
Quaternion
Mathematical notation for representing orientation and rotation of objects in three dimensions
with respect to the fixed earth coordinate quaternion. Quaternions convert the axis–angle representation of the object into four numbers and to apply the corresponding rotation to a position
vector representing a point relative to the origin.
R
Resolution
In digital systems, the resolution is the number of bits or values available to represent analog
voltages or information. For example, a 12-bit system has 4096 bits of resolution and a 16-bit
system has 65536 bits.
RMS
acronym for Root Mean Squared
Roll
In navigation roll is what occurs when a horizontal force is applied at a distance right or left from
the center of gravity of the platform, causing it to move side to side with respect to the sensor or
platform frame origin.
RPY
acronym for Roll, Pitch, Yaw
RS232
a serial data communications protocol
RS422
a serial data communications protocol
S
Sampling
the process of taking measurements from a sensor or device
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Sampling rate
rate at which the sensors are sampled
Sampling Rate
the frequency of sampling
Sensor
a device that physically or chemically reacts to environmental forces and conditions and produces a predictable electrical signal as a result
Sigma
In statistics, sigma is the standard deviation from the mean of a data set.
Space Vehicle Information
refers to GPS satellites
Streaming
typically when a device is sending data at a specified data rate continuously without requiring a
prompt from the host
U
USB (Universal Serial Bus)
A serial data communications protocol
UTC (Coordinated Universal Time)
The primary time standard for world clocks and time. It is similar to Greenwich Mean Time
(GMT).
V
Vector
a measurement with direction and magnitude with refernce from one point in space to another
Velocity
The rate of change of position with respect to time. Also called speed.
W
WAAS (Wide Area Augmentation System)
An air navigation aid developed to allow aircraft to rely on GPS for all phases of flight, including
precision approaches to any airport.
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WGS (World Geodetic System)
a protocol for geo-referencing such as WGS-84
Y
Yaw
In navigation yaw is what occurs when rotational force is applied at a distance forward or aft
from the center of gravity of the platform, causing it to move around the center axis of a sensor
or platform frame origin.
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